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Email marketing can be an effective way to 
increase both your reach and engagement  
with audience online. With the right strategy 
and tools in place, an e-newsletter can become 
a trusted source of information for timely  
and relevant updates that encourages readers 
to engage with your full complement of 
communications channels.

There are many tools for creating and 
distributing e-newsletters, and we encourage 
you to use the solution that meets your unit’s 
needs while adhering to UBC’s email standards. 
If you’re looking for an e-newsletter template 
that aligns to UBC’s visual identity standards,  
this guide will help you set up on-brand 
e-newsletters to send to your audiences.

E-newsletters at UBC

1.0
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privacy and anti-spam legislation
With the personalized nature of HTML  
email communication, it is important to 
remember that as a public organization,  
UBC is responsible for adhering to the latest 
policies and laws mandated by privacy and 
anti-spam legislation. 

If you are planning on creating and distributing 
e-newsletters, please familiarize yourself with 
UBC’s policies to ensure that you are following 
all of the guidelines, policies, and legislation 
that apply to your situation.

For example, any service used for sending 
emails to students, where there is no reasonable 
option for students to opt out, must be able  
to confirm that data is not moving outside of 
Canada (in accordance with FIPPA).

Learn more about Canadian Anti-Spam 
Legislation (CASL), Freedom of Information  
and Protection of Privacy Act (FIPPA),  
and your responsibilities for protecting  
personal information.

mass mailing tools
There are many ways to create and distribute 
e-newsletters with a range of service providers 
that offer a variety of tools and features.

The Communications portfolio is sponsoring  
a project with UBC IT to help identify  
and secure a mass mailing solution for UBC  
that addresses the varied needs of UBC 
communicators through a solution provider 
that meets FIPPA requirements. For more 
information on the mass mailing project,  
visit UBC Mass Email Tool.

In the absence of a preferred university 
solution, use a solution that best meets your 
needs and budget, bearing in mind your 
responsibility for adhering to privacy and 
anti-spam legislation.

Key considerations for email 
communication at UBC

2.0

https://universitycounsel.ubc.ca/access-and-privacy/privacy/
https://universitycounsel.ubc.ca/access-and-privacy/casl/
https://universitycounsel.ubc.ca/access-and-privacy/casl/
https://universitycounsel.ubc.ca/access-and-privacy/privacy/
https://privacymatters.ubc.ca/content/personal-information
https://privacymatters.ubc.ca/content/personal-information
https://it.ubc.ca/projects/ubc-mass-email-tool
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html email templates 
The UBC HTML email template includes:
• A clean, responsive, single-column layout 

with standardized typography that has been 
tested across multiple versions of email 
reading software

• A header region consisting of the UBC logo,  
a graphic or photo to serve as an identifier for 
the newsletter, and an additional text-based 
line to display the newsletter title as live copy 
for accessibility

• A footer region consisting of the university 
wordmark, as well as dedicated space to 
include the information required by Canadian 
Anti-Spam Legislation (CASL)

The template is available in three formats:

Basic HTML Email Template
A baseline template with HTML markup and 
CSS rules that can serve as a starting point for 
any HTML email newsletter design.

Campaigner Template*
A starter template that can be uploaded to your 
Campaigner account.

Mailchimp Template*
A starter template that can be imported into 
your Mailchimp account.

 
* Please note that these templates have been 
created in response to requests to apply updated 
UBC branding to these two commonly-used  
tools. The provision of these templates should  
not be viewed as an endorsement of these  
service providers.

The remainder of this guide provides 
information on how to create an account and 
install the template with Campaigner or 
Mailchimp. If you are adept at coding, you may 
be able to apply the Basic HTML Email Template 
to another service of your choosing. 

Each of these templates are provided as-is.  
Due to the varying nature of mass mailing needs,  
UBC is unable to provide customized templates  
nor offer support with implementation. If you 
require help, please work with your mass mailing 
service provider.

 

E-newsletter services  
and templates

3.0

https://www.campaigner.com/
https://mailchimp.com/
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campaigner 
support 
If you are experiencing issues with setting  
up an account, uploading your template, or 
distributing emails, please contact the 
Campaigner support team:

1 888 845 4544 
support@campaigner.com

Please be aware that UBC does not provide 
support for any Campaigner issues.

 
how to set up a campaigner account 
Visit Campaigner’s Pricing site. Choose the plan 
that best suits your unit’s needs. You may want 
to confirm with Campaigner that your account 
allows you to install a custom template as this 
feature may not be available by default.

If you have questions about setting up an 
account or the monthly costs, please contact 
Campaigner at 1 866 358 6388.

 
how to upload the ubc template into 
your campaigner account
1. Download the Campaigner HTML Email 
Template file from the UBC brand site.

2. Check with Campaigner if your account 
allows you to install a custom template. If it 
does, please follow the next step. If it does  
not, proceed to step 7.

 
 

 
 
3. Log into your Campaigner account, and go to 
the user icon in the upper right hand corner. 
Hover on the user icon and choose “Template” 
from the dropdown menu that appears.

4. Once on the Templates page, click the “New 
Template” button.

5. On the template upload screen, copy and 
paste all HTML markup from the UBC file into 
the editor on the right side (replacing any 
existing default code).

 

 
a. Sections that can be moved, deleted and duplicated are wrapped in a div with the 

class name “ec_repeat” 
b. Inside the section, any editable content is wrapped in a div with the class name 

“ec_item”. This is the content that will appear in the Smart Email Builder’s 
WYSIWYG editor. 

 
 
 
 

● ubcToday_templateNotes 
○ Uses placeholder images 
○ Contains 1 instance of each section 
○ Good for copy/paste sections to build other email campaigns from 
○ Each area and section is spaced out and commented to read/edit code with ease 

● ubcToday_template 
○ Contains all sections from the PSD file, includes images and links  

● ubcToday_templateReduced 
○ This template is a copy of “ubcToday_template” with suggested revisions from 

PSD file and enough sections removed to make the file size less than 70kb 

Loading Smart Email Builder Templates into Campaigner 
 

1. When logging into your account, in the upper right hand corner, hover on the user icon 
and choose Template from the dropdown menu 
 

 
 
 

2. On Templates page, click the “New Template” button 
 

 
 

3. On the template upload screen, paste all the HTML into the editor on the right side 
(replacing any existing default code) and press the “Refresh” button to see your template 
on the left side. 

Loading Smart Email Builder Templates into Campaigner 
 

1. When logging into your account, in the upper right hand corner, hover on the user icon 
and choose Template from the dropdown menu 
 

 
 
 

2. On Templates page, click the “New Template” button 
 

 
 

3. On the template upload screen, paste all the HTML into the editor on the right side 
(replacing any existing default code) and press the “Refresh” button to see your template 
on the left side. 

3.1

>

mailto:support%40campaigner.com?subject=
https://www.campaigner.com/pricing.aspx#1000
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6. Press the “Refresh” button. You should see 
the template appear on the left side. Save the 
template. Advance to step 8.

7. If the feature of installing a custom template 
is not available in your account, go to the “Full 
Email Editor” in Campaigner, select the option 
“Start from blank email”, then copy and paste all 
HTML markup from the UBC file into the editor. 

8. Please note, regardless of whether you are 
installing a new template or using the “Full 
Email Editor,” you will have to manually replace 
all the images in the newsletter template. 
Please upload the images provided with the 
UBC template to the Image Library, then 
manually replace all the images that appear 
missing or broken in the new newsletter 
template you just created.

campaigner tutorials 
Campaigner has a wealth of tutorials and 
resources to help you build and send your 
e-newsletter. The following tutorials will help 
you use UBC’s template, but we encourage  
you to explore the tutorial library.

Getting started Webinar

How to use Campaigner’s email builder  
(**highly recommended)

How to use Campaigner’s media library

Add and manage contacts in Campaigner

How to send an e-newsletter in Campaigner 
(**highly recommended)

Understanding Campaigner’s reporting tool 

 

 
a. Sections that can be moved, deleted and duplicated are wrapped in a div with the 

class name “ec_repeat” 
b. Inside the section, any editable content is wrapped in a div with the class name 

“ec_item”. This is the content that will appear in the Smart Email Builder’s 
WYSIWYG editor. 

 
 
 
 

● ubcToday_templateNotes 
○ Uses placeholder images 
○ Contains 1 instance of each section 
○ Good for copy/paste sections to build other email campaigns from 
○ Each area and section is spaced out and commented to read/edit code with ease 

● ubcToday_template 
○ Contains all sections from the PSD file, includes images and links  

● ubcToday_templateReduced 
○ This template is a copy of “ubcToday_template” with suggested revisions from 

PSD file and enough sections removed to make the file size less than 70kb 

https://www.campaigner.com/resources/
https://www.campaigner.com/resources/
https://campaigner.com/popup/webinar-registration.aspx
https://www.youtube.com/watch?v=MwbMgmDhQ78
https://www.youtube.com/watch?v=VzLl0N_y7DY
https://www.youtube.com/watch?v=a3a1Lxn3gs8
https://www.youtube.com/watch?time_continue=2&v=NlUM-TZrko4
https://www.youtube.com/watch?v=-y1V4SYPcjI
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mailchimp 
mailchimp support 
If you are experiencing issues with setting  
up an account, uploading your template,  
or distributing emails, please contact the 
Mailchimp support website.

Please be aware that UBC does not provide 
support for any Mailchimp issues.

 
how to set up a mailchimp account 
Visit Mailchimp’s pricing site. Choose the  
plan that best suits your unit’s needs. Once you 
sign up, keep your eye out for an account 
activation email. Follow the directions, and 
create your account.

For a detailed step-by-step process, visit 
Mailchimp’s account set-up page.

If you have questions about setting up an 
account or the monthly costs, please  
contact Mailchimp through their online 
ticketing system.

 
how to upload the ubc template into 
your mailchimp account
1. Login to your Mailchimp account

2. Copy the following URL and paste it in your 
browser: 

https://us5.admin.Mailchimp.com/templates/
share?id=11512863_8cbed2e1dfc48e4a67ec_
us5

3. The template should be automatically 
uploaded into the Templates folder in your 
Mailchimp account.

mailchimp tutorials 
Mailchimp has many helpful resources to help 
you create and distribute your e-newsletter. 
The following tutorials are useful if you’re just 
getting started with Mailchimp, but we 
recommend browsing through their support 
pages and resources for additional information.

Getting started in Mailchimp 
(**highly recommended)

Email Marketing Field Guide

Import Contacts

Create Emails

3.2

https://mailchimp.com/contact/
https://mailchimp.com/pricing/
https://mailchimp.com/help/create-an-account/
https://mailchimp.com/resources/
https://mailchimp.com/resources/getting-started-with-mailchimp/
https://mailchimp.com/resources/email-marketing-field-guide/
https://mailchimp.com/help/import-contacts-mailchimp/
https://mailchimp.com/help/emails/
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e-newsletter header image 
header image template 
The header image of an e-newsletter template 
not only helps communicate the content of your 
e-newsletter, but also establishes reader 
confidence and trust. To help create this trust, 
we recommend using UBC brand assets and 
referring to UBC’s visual identity guidelines 
when creating your image. 

If you’d like a little extra help in creating your 
header image, an on-brand Photoshop template 
has been included in the newsletter package for 
your use. If using the template, we recommend 
following these steps:

1. Obtain your department’s short name unit 
signature in white/reverse. 

All completed UBC unit signatures can be found 
here. If you can’t locate your unit’s signature, 
please contact the Brand and Marketing team.

2. Find an image that you would like to use in  
the header. If you’re in need of shot of campus, 
we recommend downloading an image from  
the UBC Flickr gallery.

3. Open the Photoshop template, and ensure 
that you have the “Layers” palette visible 
(Window > Layers) and the “Rulers” visible 
(View > Rulers).

 
4. Click on the “Insert image here” layer.  Go to 
File > Place Embedded and choose the desired 
background image. Resize the image to fit  
the box by holding the “shift” key and dragging 
the corners of the image. Hit “enter.”

 
5. Click on the “Insert shortname unit signature 
here” layer.  Go to File > Place Embedded and 
choose your shortname signature. Place it 
within the visible rulers. Resize by holding the 
“shift” key and dragging the corner. Hit “enter.”

 
6. In the layers palette, you will see two  
options for the UBC logo: a blue crest on a  
white background and a white crest on a  
blue background. Choose the option that works  
best with your image, and delete the other.

7. Once you are happy with the results, save 
image as a .jpeg for the newsletter. You may 
also want to save a .psd version if you plan  
on editing the image at a later date.

3.3

https://www.dropbox.com/sh/xquaeqypiseu4a9/AABqZ6OehfDySxMpiGnZWE0Pa?dl%3D0&sa=D&ust=1536094087128000&usg=AFQjCNG0PeUxqSkM6g200oAgWQGLZ_e61Q
https://www.dropbox.com/sh/xquaeqypiseu4a9/AABqZ6OehfDySxMpiGnZWE0Pa?dl%3D0&sa=D&ust=1536094087128000&usg=AFQjCNG0PeUxqSkM6g200oAgWQGLZ_e61Q
https://brand.ubc.ca/support/contact-us/
https://www.flickr.com/photos/134760388@N08/albums
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contacting support
UBC does not offer support for third-party 
email tools, such as Campaigner or Mailchimp. 
If you need assistance for either of those tools, 
including how to use the UBC templates in 
these tools, please contact their support teams.

campaigner
1 888 845 4544 
support@campaigner.com

mailchimp
https://Mailchimp.com/contact/

. 

Support

4 .0

mailto:support%40campaigner.com?subject=
https://mailchimp.com/contact/

